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Priority focuses on flexibility ~With private office and open plan furnishings, Priority supports classic and progressive
and real estate efficiency. work modes for groups and individuals. Priority benching undersurface support rails enable
long spans between legs, and ganging of adjacent tables. Height-adjustable tables include
manual or electric adjustment—from seated adjustment to sit-to-stand options with
programmable memory for three settings. Priority is SCS Indoor Advantage™ certified,
may contribute to LEED credits, and is ANSI/BIFMA level® 3 certified.
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We suggest that you familiarize yourself with the
format of this price list. You'll find information about
the product line, planning guidelines, pricing, and
how to specify the product.

How to Use this Price List

General Information

Statement of Line »See page 13

[ETMA Assembled Casegoods Statment of
Clossic. |

i

Statement of Line provides a snapshot of the
entire product line. We’ve included an illustration, a
table showing available sizes, and page cross refer-
ences to the applicable pricing and how to specify
pages.

[N Benching Solutions v

Overviews offer a quick look at the distinguishing
features of the product line.

Finishes & Materials [RETITY [
Kimba Offce

Product Information pages provide detailed infor-
mation about the product, connections that can be
made with other models, planning factors, and
applications guidelines.

. 0
Pricing pages list each model individually along
with its list prices. How to Specify steps instruct you
how to build a complete model that includes all of
its options and materials.

»See page 3 for detailed information about how to
specify Kimball Office products.

Look in the Finishes and Materials section
to see what materials and finishes are available.
Matrices for wood finishes, laminate, paint,
fabrics, and other surface materials offer a quick
reference by product.

m e
et Assurance of ualty

Use the Resources in the back of the price list.
This repository of Locking Information, Terms and
Conditions, Warranty, Operating Load Capacities,
and Filing Capacities. You'll also find a model
number index with references to the appropriate
pricing page.

Page 2
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Kimball Office has made every effort to make this
price list accurate and complete with all of the
information you need to specify our products.

Dimensions provided in this price list are nominal.
Products are manufactured to meet standard
industry tolerances.

llustrations and specifications contained in this
price list are based on the latest product informa-
tion at time of publication. Kimball Office reserves
the right to make changes at any time without
notice.

Standard product modifications are available on
select products.

»See the Product Modifications Price List at
www.kimballoffice.com

Items listed herein are considered by Kimball
Office as portable furniture and as such are
subject to local fire, electrical, and building codes
applicable to portable furniture.

Only Underwriters' Laboratory (U.L.) or Canadian
Standards Association (C.S.A.) listed electrical
components are used in electrical devices and
are so labeled.

Priority Progressive products (excluding electric
height-adjustable tables) are U.L. 962 listed.
Electric height-adjustable tables use U.L. recog-
nized components.

The customer is responsible for the proper appli-
cation of products to the local codes under which
installation must be made. Further specifications
are available on request.

c @ US LISTED
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Complete specifications are built by following a set «Standard Includes” Pricing Table Abbreviations:
« o u
Of Steps These HOW to SpeCIfy Steps are |OCated GUCEIINA 24"-36"D Rectangular Worksurfaces Pricing |StS hat S nCl ded as al’t
in the far right column of each pricing page and are Processve. ———— ISts what IS Inclu P D = Depth
specific to the models found on that page. These of the base model.
steps will guide you in the proper order to specify o W = Width
the base model, materials, finishes, options, etc. B
aioes Follow these steps to build H = Height
Base model numbers may be comprised of two or s a complete model
more steps. For concise presentation, some models cies number. T = Thickness

saKa0oewes

numbers have been truncated within the pricing
table.
® The steps numbered using a solid circle with a

AO = Approach Overhang

saKa0seweSs
SaKa072WES
saKaorawes

Selections that will incur

white number inside (e.9., @, @, or ) make up = an upcharge or decrease ED = End Depth
of the base model number. soves to the base price are noted

e Steps numbered using an outlined circle with =i within the “How to Specify” KW = Kneespace Width
black number inside (e.g., @, @, or ©) are Sries steps.

SaKaerawes

required to complete the specification. ECD

=

KH = Kneespace Height

WC = Worksurface Clearance

Kimball Office promotes the use of electronic

drawing and specification tools to automate the

furniture sales, design, and specification process.

We provide our symbol and product information to

industry leading design and specification software

companies. We work closely with 20-20 Technologies ~ Sample Specification:

Inc. to develop additional automation routines for

our products; these are available in CAP and Giza The example below shows a complete model number for an arc-top double pedestal desk.
software tools. We also partner with KISP and all »See page 135 for the corresponding pricing table and How to Specify steps.

of our products are available in The KITS collabora-

tor™. As noted in our Terms and Conditions, the @
customer bears the responsibility for order
correctness.

53K3060DDFBALW8S  F 61MB KRB G1LRMB STD MW STD MW

Base Model

Note: Steps 0 and @ were not applicable for the laminate with wood rim model and were omitted for the
specification as indicated in the How to Specify steps.

Page 3
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At Kimball Office, we are proud of our environmental
stewardship. We are committed to sustainable busi-
ness practices and continuous improvement. It’s
part of our heritage to take initiative, to reduce
waste, to conserve energy, to commit fully, and to
lead by example. It's not enough to simply sustain.
We strive to enhance our world.

Throughout our more than 40 years of documented
environmental actions, we’ve made perpetual
progress as a responsible steward of resources and
an agent of sustainable change in our industry.

In the end, we’re just beginning. Yes, the efforts
we’ve made have the clear intention of minimizing
our impacts on the planet in order to preserve a
healthy world for future generations. Ultimately, the
more we do in the area of sustainability, the more it
helps you to achieve your environmental aims. Let
us show you just how easy it is with Kimball Office.

»Find more specific details regarding the environ-
mental aspects of our product offerings at:
www.kimballoffice.com

®

ANSI/BIFMA level™

100% of the products manufactured by Kimball
Office are level® certified. We offer the most
sustainable portfolio in the industry, which includes
systems, casegoods, tables, and seating. Our
product testing team evaluates all Kimball Office
products, ensuring they meet and exceed ANSI/
BIFMA Standards. Our team members regularly
participate on BIFMA and USGBC committees to
contribute to industry-wide standards.

Sustainability

General Information

Statement of Line »See page 13

Enhancing the Home We All Share

O ecoScorecard”

Through this free online tool, you have quick, simple,
24/7 access to the environmental attributes of our
products. By partnering with ecoScorecard, we are
enabling speed and accuracy in the calculation of
environmental credits, like LEED®, as well as saving
you time and ultimately, money.

»See how easy it is at kimballoffice.ecoscorecard.com.

ecoScorecard contains credit and other information
for the following environmental rating systems:

e | EED for New Construction

e | FED for Commercial Interiors

e LEED for Existing Buildings

¢ CHPS

* | ABS21

® Green Guide for Healthcare
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LEED® Certification

Kimball Office offers furniture solutions which may
contribute toward achieving U.S. Green Building
Council certification status in your facilities. The
LEED® Green Building Rating System™ is the nation-
ally accepted benchmark for design, construction,
and operation of high performance green buildings.
Kimball Office has sought and received LEED certifi-
cation for several of its facilities across the country.
LEED-CI Gold:

e Jasper, IN showroom

e San Francisco, CA showroom

LEED-CI Silver:

e Atlanta, GA showroom

e Chicago, IL showroom

LEED-CI:

e Corporate Headquarters

e New York, NY showroom

e R&D Team Rooms

79SCScertified.

INDOOR AIR QUALITY

Indoor Advantage | Furniture

Indoor Air Quality

One of the largest contributions office furniture can
make to a building’s LEED certification is indoor air
quality via low-emitting products. For certification of
our product lines, Kimball Office uses the Indoor
Advantage program from Scientific Certification
Systems (SCS). Several of our Indoor Advantage Gold
products also meet the more stringent CAL 01350
requirements.

Design for the Environment (DfE)

is our approach to product development to ensure
the inherent sustainability of our new offerings. By
considering a full continuum of environmental
factors—including durable engineering, recycled and
recyclable materials, indoor air quality, packaging,
and beyond, we have greatly improved the life cycle
performance of our furniture.

»For environmental data, visit our website at
www.kimballoffice.com.

pura

Pura® is our proprietary wood finish that has virtually
no volatile organic compounds (VOCs). Pura is a key
part of our sustainability story, enabling a broader
range of products to meet or exceed indoor air quality
standards and help our customers achieve LEED
credits.

Planning 39
Pricing 89
Finishes & Materials 209

VA

FSC

www/sc.org
FSC* C010590

responainie foresty
FSC-Certified Wood
Due to our roots in crafting fine wood furniture, we
have a natural respect for responsible forestry.
Several series in select finishes are available in FSC
wood at a 3% upcharge. Applicable models show
FSCW as a finish price group designator option.
Standard lead times apply to FSC orders.

——

Asset Network for Education

Worldwide, Inc. (ANEW) is an easy, effective way to
responsibly disposition surplus furniture, fixtures and
equipment (FF&E). Through our partnership with this
third-party foundation, you can repurpose FF&E to
benefit those in need, while diverting materials from
landfills. ANEW calls it “Doing what’s right with
what’s left.” We call it smart.

Page 4
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Organizations now require flexible solutions for a
variety of workplace strategies addressing work BENCHING SOLUTIONS: COLLABORATION SOLUTIONS:

modes, behaviors, locations, patterns and ultimately
configurations. Priority is a versatile planning solution
with the ability to adapt as business needs
change— supporting a dynamic workplace for pro-
gressive organizations. Priority offers a broad line of
desks, tables, storage units and screens to create
intuitive solutions for all generations of individuals,
and groups.

Priority enables facility planners to strike a balance
between individual and group activities in the work-
place. Priority enables people to work healthy, move
freely and seamlessly between independent and
interactive work modes and multiple work behaviors
including enhanced collaboration.

Progressive Priority Progressive Priority

PRIVATE OFFICE SOLUTIONS: HEIGHT-ADJUSTABLE SOLUTIONS:

Classic Priority

Progressive Priority Progressive Priority

Page 5
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Priority offers you two distinctive styles and aesthet-
ics to select from when planning with Priority:

Progressive Priority details promote a table based
product with a lighter scale and ideal for more
compact offices. The floating top affect on storage
and open leg supports are the signature of
Progressive Priority. This aesthetic is evident
throughout the progressive section of this price list
from benching to private office components.

Classic Priority is the foundational elements of this
series. In this section, you will find built up desks as
well as modular components that feature a more
transitional style with worksurfaces attaching directly
to storage element.

Statement of Line »See page 13

Distinctives Introduction ~ S—
lanning 39
of Progressive and Classic Priority Pricing 89
Finishes & Materials 209

Similarities:

® Storage is available in the same heights, widths
and depths.

e Overall storage depth, width, and height are the
same in both Progressive and Classic.

¢ Softened- and reed-rim worksurfaces feature the
rim on all four sides of the surface.

24" 25"
L e
27%6" | ]
23%e6" 23%6"

Progressive Priority

Classic Priority

Differences:

¢ Classic knife-rim surfaces have the mitred rim on
the user edge only and overhangs the storage by
1%4”. Knife-rim surfaces on returns and bridges
feature a reverse knife edge for a flush fit with the
adjoining surface.

® Progressive knife-rim surfaces have the mitred rim
on all four sides of the surface and align with the
storage. Knife-rim surfaces join together without a
coped rim.

¢ Classic undersurface storage features an
unfinished, open top.

® Progressive Priority utilizes finished-top storage
with 34” spacers that mount to the worksurfaces
and undersurface support rails providing a
“floating” top affect.

¢ Classic pedestals feature a lock in the top drawer

® Progressive pedestals feature a lock in the bottom
drawer.

Vertical

Low height and mobile storage S | I Progressive Priority ||

Classic Priority Storage

Mixing Progressive and Classic Priority:
® There are numerous items in the Priority offering
that work well with both styles of Priority. Those
items not mounted below the worksurface, such
as low storage, overheads, highback organizers,
vertical storage, and tables, can be used with both
classic and progressive office layouts.
As a general guideline, classic undersurface
storage units, modesty panels, and support panels
should not be used with Progressive knife-rim
worksurfaces.
Progressive pedestals can be used with Classic
surfaces.
Mixing softened- or reed-rim worksurfaces will
work with either Progressive or Classic
arrangements.
Progressive knife-rim worksurfaces cannot be
mixed with Classic bridge and return knife-rim
surfaces.
Pedestal starter brackets, undersurface support
rails, and U-leg supports were designed to work
with Progressive products. However, pedestal
starter brackets and undersurface support rails
can be used between Classic storage units where
an unsupported span of more than 48"W is
desired. These brackets would be mounted at a
different height on Classic storage.
® Progressive end panels and Classic modesty
panels and end supports should not be mixed in
the arrangement.

Page 6



PRIORITY"

Casegoods & Benching

Post-Consumer Recycled Content:

 Priority steel components—up to 25%
e Cast aluminum parts—up to 70%

Pre-Consumer Recycled Content:

® Plastic components—up to 30%
* \Wood components—up to 85%

Energy:

e | ED lighting produces virtually no heat and uses
20% of the energy used in standard fluorescent,
for an 80% savings.

Durability:

 Priority is a durable product with a limited lifetime
warranty.

e |t is designed and constructed for longevity with
the potential for a second life.

e |t can be refurbished with new components and/or

enhancements.

Clean Technology:

The powder coating process for metal components
is virtually VOC free.

Statement of Line »See page 13

Sustainability Features Introduction S
lanning 39
Pricing 89
Finishes & Materials 209

o

IAQ/Indoor Air Quality:

¢ Certified to meet or exceed the indoor air quality
requirements set by the U.S. Green Building
Council’s LEED® rating system.

e Certified to the SCS Indoor Advantage™ standard.

* \Wood components are sealed with Pura®, our
proprietary water-based ultraviolet (UV) wood
finish.

* Metal components are sealed witha powder-
coating process that is virtually VOC free

Recyclability:

e Most Priority components are recyclable at the
end of the furniture’s useful life.

ANSI/BIFMA e3 Sustainability:

e Priority is level 3 certified to the ANSI/BIFMA E3
2010 Sustainability Standard.

LEED for Commercial Interiors:

e Priority an help customers earn valuable LEED CI
credits:
Credit 4.1 and 4.2 Recycled Content
Credit 4.5 Low-Emitting Materials
Credit 5.1 and 5.2 Regional Materials (dependant
on location)
Pilot Credit 43: Certified Products

Page 7
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Benching Application: Open Plan Application:
Laminate Wood Laminate Wood
Qty  Model Description (each) (each) Qty  Model Description (each) (each)
6 53K3072WBS*3 30"Dx72"W rectangular wksf, wire manager, $497 $672 2 53K1542VWHLFFF* 42"H vertical storage with side access wardrobe $2658 $3408
softened rim (left) and file/file
6 53K72SRUP 72" undersurface support rail set 249 249 2 53K1542VWHRFFF* 42"H vertical storage with side access wardrobe 2658 3408
2 53KB028SLUEAP 60"Dx28"H adjustable-height end-support U-leg 922 922 (right) and file/file
2 53K6028SLUMAP 60"Dx28"'H  adjustable-height mid-support U-leg 1067 1067 4 53K3072WBS"3 30"Dx72"W rectangular wksf, wire manager, 497 672
ftened ri
3 53K7212PSR 72"Wx12"H resin privacy screen 384 384 softened im
4 53KEPSBP End panel/pedestal starter bracket to vertical storage 100 100
5 53KPSBU2P Resin privacy screen attachment brackets (set of 2) 55 55 i i 9
. : - ) 4 53K72SRUP 72" undersurface support rail set 249 249
4 53K2812PSER 28"Wx12"H resin end-support privacy screen 145 145
2 99K62PDD Power/data drawer, 62"W, (shared 188 188
4 53KPSBFP Resin privacy screen freestanding brackets (set of 2) 55 55 ( )
- 1 53K6028SLUMSP 60"Dx28"H fixed-height mid-support U-leg 934 934
6 53K163022PFOLF* 16"Dx30"Wx22"H open/lateral file low storage 737 1207
- 2 53K6612PSR 66"Wx12"H resin privacy screen 344 344
6 53K14300S* 14"Dx28"w organizer shelf 190 359
- - 3 53KPSBU2P Resin privacy screen attachment brackets (set of 2) 55 55
6 53K163022PFBLF* 16"Dx30"Dx22"H wide box/lateral file low storage 856 1404
" . - TOTAL $15835 $19535
6 53K1630PC 30"Wx16"D cushion top for low storage, grade 1 413 413
1 99KWMF Wire manager fillers (set of 6) 37 37
TOTAL $23894 $32066

* Represents either L for laminate or W for Wood.
Note: Accessories and electrical components are not included in these typical configurations.
»See pricing section.

Page 8
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PRIORITY” Typical Configurations Introduction St -
Casegoods & Benching continued Pricing -
Finishes & Materials 209

Conferencing Application: Traxx and Tiles Application:
Laminate Wood Laminate Wood
Qty Model Description (each) (each) Qty Model Description (each) (each)
1 53K60144WBS* 60"Dx144"W rectangular worksurface, softened rim $3869 $5395 1 53K243022PFOLF* 24"Dx30"Wx22"H open/lateral file low storage $856 $1404
4 53K72SRUP 72" undersurface support rail set 249 249 1 53K23300S* 22"Dx28"W organizer shelf 235 438
2 53K6028SLUESP 60"Dx28"H fixed-height end-support U-leg 756 756 1 53K243022PFBLF* 24"Dx30"Wx22"H wide box/lateral file low storage 997 1632
1 53K6028SLUMSP 60"Dx28"H fixed-height mid-support U-leg 934 934 3 53K163022BCO* 16"Dx30"Wx22H open bookcase low storage 733 966
TOTAL $7311 $8837 2 53K143008* 14"Dx28"W organizer shelf 190 359
1 53K2430PC 24"Dx30"W cushion top for low storage, grade 1 444 444
1 53K2430CPT* 24"Dx30"W rectangular component top for low storage 189 353
1 53K1690CPT* 16"Dx90"W rectangular component top for low storage 472 641
1 53K2490WBS*3 24"Dx90"W rectangular worksurface with wire manager 522 697
1 53K90SRUP 90" undersurface support rail set 350 350
2 53K2405EP* 24"Dx5"H fixed-height end panel for 22"H low storage 135 225
2 53KEPSBP End panel/pedestal starter bracket 100 100
3 53K3019SOH*T 16"Dx30"Wx19"H solid hinged-door overhead; 704 1074

Traxx mount

2 TTWMT144 144"W set of 2 Traxx and 4 splice plates 449 449
3 FIT3037A 30"Wx37"H fabric tile, grade 1 337 337
4 FIT3037M 30"Wx37"H markerboard tile 515 515
2 TTET40 Full end trim 91 91
1 53K36RD 36"-diameter table top 443 925
. . . 1 53K26BRGMP Adjustable height round table base 2501 2501
N’;tee?rjiire)tsssgrl;gira;;o;lfg;rlirc)zl;ecg:nlf/ovofgnvz‘zogg not included in these typical configurations. ! 9OKWMF Wire manager filers (set of 6) 87 87
TOTAL $16358 $21061

»See pricing section.
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M0l (N4 Typical Configurations Introduction .
. Planning 39
Casegoods & Benching _ Pricing -
continued
Finishes & Materials 209
Progressive Private Office Application: Classic Private Office:
1
H H
1
g /-
= © = | =
= =
i H 5
Laminate Wood Laminate Wood
Qty Model Description (each) (each) Qty Model Description (each) (each)
1 53K3078WBS* 30"Dx78"W rectangular worksurface, softened rim $489 $669 1 53K3672WSS* 36"Dx72"W rectangular desk worksurface, softened rim  $622 $700
1 53K78SRUP Worksurface support rail set 266 266 1 53K3628SLUSAP 36"Dx29"H end support u-leg 645 645
2 53KB028EPS* 30"Dx27"H fixed-height end panel 271 450 1 53K3618SESR* 36"Dx18"W right end-support panel 535 882
2 53KEPSBP End panel starter bracket 100 100 1 53K2466RREF*10 24"Dx66"W return with multi-file pedestal on right 1861 2866
1 53K7212PSR 72"Wx12"H resin privacy screen 384 384 1 53K3067VWHLOS* 24"Dx30"W x 67"H wardrobe with open shelves 2414 3217
1 53KPSBSP Resin privacy screen attachment brackets (set of 2) 55 55 (non-locking)
2 53K163022PFBLF*  16"Dx30"W x 22H wide box/lateral file low storage 856 1404 1 53K7238HBH" 16"D|X72K".W hinged-door highback organizer 1479 2930
non-lockin
2 53K163022BCO* 16"Dx30"W x 22H open bookcase low storage 733 966 ( 9
1 53K1538BCO* 16"Dx15"W set on open bookcase 415 821
2 53K1660CPT* 16"Dx60"W rect. component top for low storage 300 480
— 1 53K1538BCHR* 16"Dx15"W set on bookcase with door hinged right 613 1214
2 53K6016SOST* 16"Dx60"W x 16"H solid sliding-door overhead; 1054 1550 ;
(non-locking)
Traxx mount
- 1 KAC7016TBK Tackboard, grade A fabric 409 409
1 53K1867VWHR* 24"Dx18"W x 67"H single-door wardrobe/storage 2062 2722
hinge right (non-locking) TOTAL $9093 $13684
1 WMT144 Set of 2 Traxx and 4 splice plates 449 449
FITBO37A 60"Wx37"H fabric tile 413 413
TTET40 Full end trim 91 91
TOTAL $11341 $15453

* Represents either L for laminate or W for Wood.
Note: Accessories and electrical components are not included in these typical configurations.
»See pricing section.

Page 10
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Height-Adjustable Tables Application:

Laminate Wood
Qty Model Description (each) (each)
1 53K2467VBWHLBBF*  24"D x 24"W x 67"H side-access vertical storage $2750 $3525
tower with wardrobe (non-locking doors)
1 53K2467VBWHRBBF*  24"D x 24"W x 67"H side-access vertical storage 2750 3525
tower with wardrobe (non-locking doors)
53K3060WBS* 30"D x 60"W rectangular worksurface, softened rim 380 552
53K2460TBTDEMP 24"D x 60"W Electronic height-adjustable 2332 2332
dual-stage base
53K4816PSR 48"W x 16"H resin privacy screen 299 299
53KPSBU2P Resin privacy screen attachment brackets for 55 55
softened rim (set of 2)
2 53K16CMSD Dual stage snap on cable manager 78 78
TOTAL $11788 $13682

* Represents either L for laminate or W for Wood.
Note: Accessories and electrical components are not included in these typical configurations.
»See pricing section.
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The big picture. In setting priorities, sometimes it helps to get the big picture. This statement of line
provides an snapshot of the entire Priority product offering.
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™ IMPORTANT: All di i h bel
=lel={un4 Worksurfaces Statement of Line TeISIonS SR Seor

are nominal and have been rounded to the
Progressive nearest inch. Refer the appropriate pricing
pages for actual dimensions.

< < -

Rectangular Wedge Oval

® = Rim on 4 sides »See page 94 to specify. »See page 95 to specify.
M = Wire manager on back side; rim on front and sides

»See pages 90-92 to specify.

36"W  42'W  48'W  B54'W  B0'W  66'W  72'W  78'W  84"W  90'W  96"W  120"W  144'W 72"W 78'"W
24"D om om om om om om om om om om om 36'D L 42'D L4
30"D (] | (] | (] | (] | (] | (] | (] | (] | (] | (] | (] |
36'D om om om om om om om om om om om
48'D ° ° ° ° ° ° ° ° ° °

60"D

< >
= <= <

Arc End U-Shaped Extended 90° and 120° Corner
»See page 93 to specify. »See page 96 to specify. »See page 97 to specify. ©® = Rim on all sides
W = Wire manager on back
side; rim on other sides
»See pages 98-99 to specify.

42"W  48'W  54"W  60'W  B6"'W  72'W  78'W  84"W  90"W 72"W 48"W
24"D ° ° ° ° ° ° ° ° ° 36'D o 24"D om
30"D ° ° ° ° ° ° ° ° ° 30"D ol
36"D ° ° ° ° ° ° ° ° °
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Hai[els{lh4 Undersurface Support

Statement of Line

IMPORTANT: All dimensions shown below
are nominal and have been rounded to the

P :
rogressive Rails and Legs

R

Undersurface Support Rails
»See page 102 to specify.

For use with unsupported span of:

S

Return Mounting
Bracket
»See page 102 to specify.

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

-~ =y []

End-Support Open-Frame Legs

28"H models available in fixed- and adjustable-height (push button
on 24"-36"D; screw adjust on 48"-60"D).

»See page 103 to specify.

36'W  42"W  48'W  54'W  60"W  66'W  72'W  78"W  84'W  90'W = 96"W 20"W 24'D 30"'D 36"D 48'D 60"D
1D ° ° ° ° ° ° ° ° ° ° ° 5"D* ° 5"H °
11"H ®
28"H ° ° ° ° °

End-Support U-Legs

Available in fixed- and adjustable-height models (push button on 24"-36"D;
screw adjust on 48"-60"D).

»See page 104 to specify.

Mid-Support U-Legs
Available in fixed- and adjustable-height models (screw adjust).
»See page 105 to specify.

Stanchion Mid-Support
U-Legs

Available in fixed- and
adjustable-height models
(screw adjust).

»See page 107 to specify.

Stanchion End-Support
U-Legs

Available in fixed- and adjustable-
height models (screw adjust).
»See page 106 to specify.

24'D 30'D 36'D 48'D 60"'D 24'D  30'D 36'D 48'D  60'D 50'D  62'D 50'D  62'D
28"H ° ° ° ° ° 28"H ° ° ° ° ° 28"H* ° ° 28"H* ° °
* Leg height * Leg height

Statement of Line

Page 15




Mol {ipd Support

IMPORTANT: All dimensions shown below

Statement of Line

Progressive

90° Corner Support Frames with Stanchions

Available in fixed- and adjustable-height models (screw adjust).

Includes undersurface support rails.
»See page 108 to specify.

For use with 90° worksurfaces:

Corner Supports and End Panels

120° Corner Support Frames

are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing

pages for actual dimensions.

Available with or without stanchions, and in fixed- and adjustable-height

models (screw adjust).
»See page 109 to specify.

For use with 120° worksurfaces:

24" x 48" 30" x 48" 24" x 48" 30" x 48"
28"H* ° ° 28" H* ° *
* Leg height * Leg height

=

End Panels
»See page 113 to specify.

End Panels for use with Benching Stanchions
»See page 113 to specify.

Starter Brackets for End
Panel or Pedestal
»See page 113 to specify.

Stanchions for End
Panel or Pedestal
»See page 113 to specify.

24'D 30"D 36'D 48'D 60"D 50"D 62"D 22"'D 5'D
5"H L4 28"H L L 14"W L 2"W L
11'H e
28"H ° ° ° ° °

Page 16 Statement of Line




Slat/Fabric
»See page 110 to specify.

Progressive

Fabric
»See page 110 to specify.

H[elz{ipMN Tiles & Top Caps

Statement of Line

For Use with Stanchions

Slat

»See page 111 to specify.

IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing
pages for actual dimensions.

36'W  42'W  48'W  54'W  B0"W  66'W  72'W  78'W  84'W  90'W  9B6'W
18"H ° ° ° ° ° ° ° ° ° ° °
Benching Top Caps
»See page 112 to specify.
36'W  42'W  48'W  54'W  B0"W  66'W  72'W  78'W  84"'W  90'W  9B6'W For 90° For 120°
3'D ° ° ° ° ° ° ° ° ° ° ° ® (sef) ® (set)

Page 17
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-

Box/Box/File Pedestal
»See page 114 to specify.

Progressive

Mei[0lZ{Ip4N Storage

Statement of Line

IMPORTANT: All dimensions shown below

&

File/File Pedestal
»See page 114 to specify.

Undersurface Storage

B

Lateral File Pedestal
»See page 114 to specify.

15"W 15"W 30'w
24'D ° 24'D ° 24'D °
30'D 30'D °
36'D ° 36'D °

-

Box/Box/File—Box/Box/File

Double-Sided Pedestal
»See page 115 to specify.

P

File/File—File/File
Double-Sided Pedestal
»See page 115 to specify.

-

Box/Box/File—File/File
Double-Sided Pedestal
»See page 115 to specify.

-

Box/Box/File—Box/Box/File
Double-Sided Pedestal for
use with Stanchion

»See page 115 to specify.

are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing

pages for actual dimensions.

File/File—File/File

Double-Sided Pedestal for

use with Stanchion
»See page 115 to specify.

-

Box/Box/File—File/File
Double-Sided Pedestal for use
with Stanchion

»See page 115 to specify.

15"W 15"W 15"W 15"W 15"W 15"W
48"D ® 48"D ® 48"D ® 50"D ® 50"D ® 50"D ®
60"D ® 60"D ® 60"D ® 62"D ® 62"D ® 62"D ®

Page 18
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™ . IMPORTANT: All dimensions shown below

PRIORITY Storage Statement of Line are nominal and have been rounded to the

Progressive nearest inch. Refer the appropriate pricing
Overhead Storage pages for actual dimensions.

P _

Center-Mount Overheads Center-Mount Overheads Interior Shelves
with Sliding Door with Hinged Doors For use in sliding-door cabinets.
Available with solid or Available with solid or »See page 120 to specify.
writable glass door. writable glass door.
»See page 116 to specify. »See page 117 to specify.
30'W  36"'W  42'W  48'W  B54'W  60"W  66'W  72"W 15'w 18'w - 21'w 24'wW 27'W 30'W  33'W  36'W
16"D ° ° ° ° ° ° ° ° 15"D ° ° ° ° ° ° ° °

= =<

Center-Mount Straight Shelves Center-Mount Mitred Shelf Sets for 90° and 120°
»See page 118 to specify. Applications
»See page 119 to specify.

30'W  36"'W  42'W  48"'W  54'W  60"W  66'W  72'W  78'W  84"'W  90"'W = 96"W 49"W

15"D L] L] L] L] L] L] L] L] [ ] [ ] [ ] [ ] 15"D [

Page 19 Statement of Line




PRIORITY"

Privacy Screens

IMPORTANT: All dimensions shown below

Statement of Line are nominal and have been rounded to the

Progressive

o

Resin Privacy Screens

® = Standard screen

M = End-support screen

»See pages 121-122 to specify.

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

21'"W - 24'wW 27'w 30'W 33'W  36'W  42'W  48'W  54"W  60'W  e6'W  72'wW 78'W  84"W  90'W
12"H n ° n ° n ° ° ° ° ° ° ° ° ° °
16"H n ° n ° n ° ° ° ° ° ° ° ° ° °
Resin Privacy Screen Attachment Brackets Wood or Laminate Click-Adjust Privacy Screens
Available for: »See page 124 to specify.

¢ Freestanding

® Surface top

® Edge of softened or reed rim
® Edge of knife rim

»See page 1283 to specify.

Statement of Line

Page 20

36'W  42'W  48'W
28"H ° ° °




PRIORITY"

Height-Adjustable Bases

Statement of Line

IMPORTANT: All dimensions shown below
are nominal and have been rounded to the

Progressive

T-Leg Bases
® = Main (2 legs and rails)
M = Return (1 leg and rails)

»See pages 125-126 for manual-adjust models; pages 129-130 for electric-adjust models.

For Use with Worksurfaces:

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

90° and 120° Bases
»See page 128 for manual-adjust models.
»See page 132 for electric-adjust models.

For Use with 90° or 120° Worksurfaces:

36'W  42"W  48'W  54'W  e0'W  e66'W  72'W  78'W  84'W  90'W  96"W 24" x 48" 30" x 48"
Manual Adjust Manual Adjust
Incremental ® (] | (] | (] | (] | (] | (] | (] | (] | (] | Incremental
Click ® (] | (] | (] | (] | (] | (] | (] | (] | (] | Click
Crank ° ° ° ° ° ° ) ) ) ° Crank
Electric Adjust Electric Adjust
Single stage [ (] | (] | (] | (] | (] | (] | (] | (] | (] | Single stage
Dual stage ® (] | (] | (] | (] | (] | (] | (] | (] | (] | Dual stage

Extension Post-Leg Bases
»See page 127 for manual-adjust models.
»See page 131 for electric-adjust models.

For Use with Worksurfaces:
42'W - 48'W B4'W  60"W

Manual Adjust

Incremental

Click

Electric Adjust

Single stage

Dual stage

Statement of Line

Page 21

Bridge Worksurface Attachment Bracket Kit
»See page 133 to specify.

For Use with Worksurfaces:
42"W  48'W  54"W  60"W  66'W  72'W

6"W ° ° ° ° ° )

o |

Casters, Control Box Jumper Cords, and
Snap-On Cable Managers
»See page 134 to specify.




IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing
pages for actual dimensions.

PRIORITY"

Classic

Assembled Casegoods Statement of Line

Desks, Returns, and Bridges

Rectangular-Top
Double Pedestal Desks
»See page 135 to specify.

Arc-Top Double
Pedestal Desks
»See page 135 to specify.

Rectangular-Top

Single Pedestal Desks
Available in left and right models.
»See page 136 to specify.

Arc-Top

Single Pedestal Desks
Available in left and right models.
»See page 137 to specify.

Extended-Top Single
Pedestal Desks

Available in left and right models.
»See page 138 to specify.

Center Drawers
»See page 139 to specify.

60"W  66'W  72'W 60"'wW  72'W 66"'W  72'W 66"'W  72'W 72"W 18'"W  30'W  36'W
30D L L L 30D L 30D L 30D L 42'D L 22'D e L o
36"D ° 36"D L 36"D L 36"D L
2]
7
File/File Pedestal Multi-File Pedestal Bridges

Executive Returns
Available in left and right models.
»See page 140 to specify.

42"'W - 48"'W

Executive Returns

Available in left and right models.

»See page 140 to specify.

66"W

24'D ° °

Page 22

24'D ®

Statement of Line

»See page 141 to specify.

30'W  36'W  42'W

48"W

24'D ° ° °




A

\l
.\ﬁ i‘
l
Storage Credenzas
»See page 142 to specify.

66"'W  72'W

PRIORITY"

Assembled Casegoods

Statement of Line

Classic

Kneespace Credenzas
»See page 142 to specify.

66'W  72'W

Credenzas and Transaction Counters

Single-Pedestal Credenzas
Available in left and right models.
»See page 143 to specify.

66"'W  72'W

Lateral File Credenzas
Available in left and right models.
»See page 143 to specify.

72"W

24"D ® ®

=

Transaction Counters
»See page 144 to specify.

65"W

24"D ® ®

12D e

Page 23

Statement of Line

24"D ® ®

24"D ®

IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing
pages for actual dimensions.




™ . IMPORTANT: All di i h bel
a{[elz:{ip@M Modular Components Statement of LiNe  are romnal and hive boon rounded 1 the

Classic nearest inch. Refer the appropriate pricing
Worksurfaces pages for actual dimensions.
Rectangular Desk Arc Desk Worksurfaces P-Shaped Worksurfaces U-Shaped Worksurfaces Corner Worksurfaces
Worksurfaces »See page 145 to specify. Available in left and right models. »See page 146 to specify. »See page 149 to specify.
»See page 145 to specify. »See page 146 to specify.
60"W  66'W  72"'W 72"W 72"W 66"H 72'H 84"H 36"W  42'W
30'D ° ° 36"D 4 30'D 4 30"W ° 36"D 4
36"D L4 42'D L4 36"W ° ° 42'D L4

Rectangular Worksurfaces
»See pages 147-148 to specify.

30'W  36"'W  42'W  48'W  B54'W  e0'W  ee'W  72'W  78'W  84"W  90'W  96'W 102"W 108"W 120"W
24"D ° ° ° ° ° ° ° ° ° ° ° ° ° ° °

Page 24 Statement of Line




IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing
pages for actual dimensions.

PRIORITY"

Modular Components Statement of Line

Classic
Storage

Box/Box/File Pedestals
»See page 151 to specify.

File/File Pedestals
»See page 151 to specify.

< =
T

Hinged-Door Storage
»See page 152 to specify.

Two-Drawer Lateral File
Pedestals
»See page 152 to specify.

Multi-File Pedestals
Available in box/box/open/lateral
and box/box/file/lateral models.
»See page 152 to specify.

Printer/CPU Storage
»See page 152 to specify.

15'W 18w 15'W 18w 30'W  36'W 30'W  36'W 30'W  36'W 36"W
24D e B 24D e B 24D e o 24D e o 24D e o 24D @
30D @ D 30D @ °
36'D 36'D

53'H 53"H

40"H

Three-Drawer Lateral Files
with Open Top
»See page 153 to specify.

30'W  36"W

Four-Drawer Lateral Files
with Open Top
»See page 153 to specify.

30'W  36"W

B

Two-Drawer Lateral Files
with Finished Top
»See page 154 to specify.

30'W  36"W

{41'H

Three-Drawer Lateral Files
with Finished Top
»See page 154 to specify.

30'W  36"W

Four-Drawer Lateral Files
with Finished Top
»See page 154 to specify.

30'W  36"W

24"D ° °

Page 25

24"D ° °

Statement of Line

24"D ° °

24"D ° °

24"D ° °

]

i _
Ganging Brackets
»See page 207 to specify.




™ . IMPORTANT: All di i h bel
{[elz:{ip@M Modular Components Statement of LiNe  are romnal and hive boon rounded 1 the

Classic nearest inch. Refer the appropriate pricing
Modesty Panels pages for actual dimensions.

i

Hinged Modesty Panels Modesty Panels for U- and P-Shaped Worksurfaces
»See page 155 to specify. ® = Wood or laminate
MW = Glass

»See page 156 to specify.

For use with U- or P-shaped worksurfaces:

2'w - 18'W 24'W 30'W 36'W 42'W 48'W 54"W 66"W  72'W  84'W
28"H ° ° ° ° ° ° ° ° 10"H n n ™
28"H L4 L4 L4

Page 26 Statement of Line




N

End Supports

Available in left and right models.
»See pages 157-158 to specify.

Ma[elz{iA4 Modular Components

Classic

-

RN

-
-
-
5
z
z2
22

Worksurface Mid-Support
Panels
»See page 158 to specify.

W\

IMPORTANT: All dimensions shown below

Statement of Line are nominal and have been rounded to the

Support

Corner Supports
»See page 159 to specify.

End Support Panels
»See page 160 to specify.

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

T-Leg End Support Panels
»See pages 160-161 to specify.

15"'W  18'W 36'W  42'W 30'D 36'D 24'D 30'D 36'D
24"D 11"D ° 36"D ° 28"H o o 6"H o
30"D ® 42"D ® 12"H ®
36"D 28"H o

=

Support Drawers
»See page 162 to specify.

15"D

Nz

Support Shelves

»See page 162 to specify.

15"D

5'H °

Page 27

'H e

Statement of Line

I

Support Columns
Available in column and
half-cylinder models.
»See page 163 to specify.

Adjustable-Height U-Legs
Available in end- and mid-support models.

»See page 164 to specify.

10"D 24'D

30'D 36D

28"H °

28"H ° °




™ IMPORTANT: All di i h bel
PRIORITY Storage Statement of Line imensions shown below

are nominal and have been rounded to the

Progressive/Classic ] nearest inch. Refer the appropriate pricing
Mobile Pedestals pages for actual dimensions.

G B G- B

Cushion-Top Box/File Box/Box/File File/File Mobile Pedestals Active File Mobile Pedestals
Mobile Pedestals Mobile Pedestals »See page 166 to specify. »See page 166 to specify.
»See page 166 to specify. »See page 166 to specify.
15"W 15"W 15"W 15"W
24'D o 24'D o 24'D o 22'D o

Page 28 Statement of Line




PRIORITY"

Progressive/Classic

Low Storage Open Bookcase
»See page 167 to specify.

Storage

IMPORTANT: All dimensions shown below

Statement of Line are nominal and have been rounded to the

Low Storage

P

Low Storage with Wide Box
and Lateral File Drawer
»See page 168 to specify.

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

1 P (B

Low Storage with Lateral File Drawer
Available in lateral file and open/lateral file models.
® = Freestanding

W = Mobile

»See page 169 to specify.

30'W  36'W 30'W  36'W 30'W  36'W
16D @ o 16D ® o 16'D em  om
24D e o 24D e o 24'D em  om

-

Component Tops
»See page 170 to specify.

<

Cushion Tops
»See page 171 to specify.

Straight Shelves
»See page 172 to specify.

<~

Organizer Shelves
»See page 172 to specify.

Modesty Panel/
Cable Surround
»See page 173 to specify.

30'W  36'W  60"'W  66'W  72"W  90'W 108'W 30'W  36"W 28'W  34'W 28'W  34'W 48W  60"W
16"D [ ] [ ] [ ] [ ] [ ] [ ] [ ] 16"D [ ] [ ] 15"D [ ] [ ] 15"D [ ] [ ] 6"H [ ] [ ]
24'D o o o o o o o 24'D o o 22'D o o 22'D o o 12"H o o

Page 29
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™ . IMPORTANT: All dimensions shown below
PRIORITY Storage Statement of Line are nominal and have been rounded to the
Progressive/ClassiC ] nearest inch. Refer the appropriate pricing
Overheads and Highbacks pages for actual dimensions.

N2

Sliding-Door Overhead Cabinets Sliding-Door Highback Organizers Interior Shelves
Available with solid or writable glass door; wall or Traxx mount Available with solid or writable glass door For use in wall-mount sliding-door overheads.
»See page 174 to specify. »See page 176 to specify. »See page 175 to specify.
30'W  36"'W  48'W  60"W  66'W  72"W 60'W  66"'W  72'W  90"W  96"W 102'W 108'W 13'W 1e'W - 22'w 28'W 31'W  34"'W
16"H ° ° ° ° ° ° 33"H ° ° ° 14"D ° ° ° ° ° °
38"H ° ° ° ° ° ° °

<

7" @B

Hinged-Door Overhead Storage Hinged-Door Highback Organizers Filler Strips for Overhead Storage
Available with solid, glass, or writable glass doors; for wall or Traxx mount Available with solid, glass, or writable glass doors »See page 207 to specify.

® = Two-door models ® = Four-door models

A = Three-door models B = Six-door models

B = Four-door models »See page 178 to specify.

»See page 177 to specify.

30'W  36'W  48'W  60"W  66'W  72"W 60'W  B66"'W  72'W  90"W  96'W 102'W 108'W 16"H 19"H
19"H ° ) A | | ] 38"H ° ° ° | ] ] | | 2'D ° )
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Tackboards
For use with 38"H highback organizers or wall-mountable.
»See page 179 to specify.

Mei[0lZ{Ip4N Storage

Statement of Line

Progressive/Classic

46'W  49"'W  52'W  58'W  64'W  70'W

88"W

Tackboards, Slatwall, and Set-on-Surface Storage

Metal Slatwall
For use with 38"H highback organizers.
»See page 179 to specify.

60"'W  66"W  72"'W

16"H

Set-on-Surface Open

Bookcases

»See page 180 to specify.

Set-on-Surface Bookcases
Available in single- and double-
door models; solid, glass, and
writable glass doors.

»See page 181 to specify.

Set-on-Surface Organizers
Available with solid, glass, and
writable glass doors.

»See page 182 to specify.

13"H o o o

<>

Project Trays
»See page 182 to specify.

38" 38'H 38'H 16"W
1B5'W e 15'W e 1B5'W e 14D e
18w e 8w e Bw e
oW e o'W e
36"W L] 36"W ®

Page 31

IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing
pages for actual dimensions.

Statement of Line




IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing

Mei[0lZ{Ip4N Storage

Progressive/Classic

Statement of Line

Space Dividers

Available in full- and partial-back

models.
»See page 183 to specify.

49"H

16"D

Bookcases with Lateral

File

Available in full- and partial-back

models.
»See page 184 to specify.

49"H

Vertical Storage

Bookcases with Sliding
Door and Lateral File
Available with solid door or
writable glass door; full- and
partial-back models.

»See pages 185-186 to specify.

67"H  80'H

Bookcases with Hinged
Doors and Lateral File
Available with solid doors or
writable glass doors; full- and
partial-back models.

»See pages 187-188 to specify.

67"H  80'H

pages for actual dimensions.

<~

Organizer and Straight
Shelves

® = Organizer shelf

M = Straight shelf

»See page 189 to specify.

15'W  34'W

Back Panels
»See page 189 to specify.

21"H 22"H

30"W °

V

\

Bookcase with File/File
»See page 190 to specify.

36"W °

Front-Access

Storage Towers
Available with box/box/file or
file/file; left and right models.
»See page 191 to specify.

36"W o o

Side-Access Storage Towers

Available with box/box/file or
file/file; left and right models.
»See page 192 to specify.

36"W o o

Side-Access Wardrobe
Storage Towers
Available with box/box/file or
file/file; left and right models.
»See page 198 to specify.

14'D L ol

\VAVAVAVAVA’

Single-Door Cabinets
»See page 194 to specify.

36"W L L

Double-Door Cabinets
® = \Wardrobe
M = Lateral File
»See page 195 to specify.

42"H 49"H 67"H 42"H 49"H 67"H 42"H 49"H 67"H 42"H 49"H 67"H 67"H 67"H
15"W ° ° ° 24"W ° ° ° 24"W ° ° ° 15"W ° ° ° 18"W L] 30"W L
30"W L] 36"W ol

Page 32
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™ IMPORTANT: All di i h bel
PRIORITY Storage Statement of Line imensions shown below

are nominal and have been rounded to the

Progressive/Classic _ nearest inch. Refer the appropriate pricing
Freestanding Bookcases pages for actual dimensions.

= &
/'4\ ‘/1
] <
<] \/'4
)’1\ | >
- [~

Shelving Units Straight-Front Bookcases Arc-Front Bookcases

»See page 196 to specify. »See page 197 to specify. »See page 198 to specify.
42"H 50"H 28'"H  67"H 80"H 84"H 28"H  40"H 53"H 67"H
36"D b b 36"W L] L] L] L] 36"W L] L] L] L]

Page 33 Statement of Line




Progressive/Classic

-

Round
»See page 199 to specify.

Hai(olzilndN Tables

IMPORTANT: All dimensions shown below

Statement of Line are nominal and have been rounded to the

<>

Square
»See page 199 to specify.

Tops, Modesty Panels, and Freestanding Table Bases

Racetrack
»See page 200 to specify.

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

— K

Elliptical Square Occasional
»See page 200 to specify. Table
»See the Tables Price List.

36'W  42"W  48"W  60"W 72"W 72"W 24"W
36" diameter L4 36"D L4 36"D L 40"D L 24"D L4
42" diameter b 42"'D b
48" diameter ° 48"D °
60" diameter L4 60"D L4

H/////////H =
= o 4'}
Glass Modesty Panel Round Metal Bases Square Metal Bases Column Legs Cylinder Bases
»See page 200 to specify. »See page 201 for fixed height. »See page 201 for fixed height. Available in static and mobile. Available in laminate and wood.
»See page 202 for adjustable »See page 202 for adjustable »See page 201 for fixed height. »See page 201 to specify.
height. height. »See page 202 for adjustable
height.
9"H 28"H 28"H 28"H 28"H
36"W L4 24" diameter L 24" square L 2" diameter L 16" diameter L

Page 34
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IMPORTANT: All dimensions shown below

PRIORITY Tables Statement of Line are nominal and have been rounded to the
Progressive/CIassic nearest inch. Refer the appropriate pricing
T-Leg Table Bases pages for actual dimensions.

Fixed-Height T-Leg Bases Fixed-Height 90° and 120° Bases
® = Main (2 legs and rails) »See page 206 to specify.

W = Return (1 leg and rails)

»See pages 203-204 to specify.

For Use with Worksurfaces: For Use with 120° worksurfaces:
36'W  42"W  48'W  54"'W e0'W  e6'W  72'W  78'W  84"W  90'W  96"W 24" x 48" 30" x 48"
28"H ° om om om (] | (] | (] | (] | (] | (] | o 28"H L °

Fixed-Height Extension Post-Leg Bases
»See page 205 to specify.

For Use with Worksurfaces:
42"W  48'W  54"W  60"W

28"H o [ [ °

Page 35 Statement of Line




Kimball Office

Power/Data Drawers
»See page 64 for Priority
Power/Data Overview.
»See the Perks Price List to

specify.

Power/Data Centers
»See the Perks Price List to

specify.

Page 36

Related Perks® Products

. IMPORTANT: All dimensions shown below
Statement of Line are nominal and have been rounded to the

Single-Circuit Power Components
»See page 64 for Priority Power/Data
Overview.

»See the Perks Price List to specify.

Y 7777 77T Z 7 I T I T

(RS

7

Flexchain Cable Manager Expandable Cable Manager
»See the Perks Price List to »See the Perks Price List to
specify. specify.

nearest inch. Refer the appropriate pricing
pages for actual dimensions.

Four-Circuit (8-Wire) Power Desk Lamps
Components »See the Perks Price List
»See page 64 for Priority Power/Data Overview. to specify.

»See the Perks Price List to specify.

W

Undersurface Cable Wire Manager Filler Round Grommets
Managers »See the Perks Price List to »See the Perks Price List to
»See the Perks Price List to specify. specify.

specify.

Statement of Line



Kimball Office

Paper Trays
»See the Perks Price List to
specify.

Laptop Arms
»See the Perks Price List to
specify.

Page 37

Related Perks® Products

Statement of Line

Utility Trays
»See the Perks Price List to
specify.

8

Monitor Arms

Available in standard and
heavy-duty models.

»See the Perks Price List to
specify.

Statement of Line

continued

T

Accessory Dishes
»See the Perks Price List to

specify.

Grommet-Mount Brackets
Available in single- and dual-

arm models.
»See the Perks Price List to
specify.

Carousel Center Drawers

»See the Perks Price List to
specify.

Clamp-Mount Brackets

Available in single- and dual-

arm models.
»See the Perks Price List to
specify.

©

IMPORTANT: All dimensions shown below
are nominal and have been rounded to the
nearest inch. Refer the appropriate pricing
pages for actual dimensions.

Slatwall-Mount Brackets

specify.

»See the Perks Price List to




IMPORTANT: All di i h bel
Related Casegoods & Tables Products Statement of Line  are nominal and have been raundod o the

K| m bal |JOffICG nearest inch. Refer the appropriate pricing
pages for actual dimensions.

LED Lights Task Lights 40" Power/Data
»See the Universal »See the Universal Centers Centers

chapter in the Casegoods chapter in the Casegoods »See the Contemporary »See the Contemporary
Price List. Price List. Tables chapter in the Tables chapter in the

Tables Price List. Tables Price List.
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PRIORITY™

Casegoods & Benching

Plan your Priority.

PLANNING

Table of Contents

This section will help you design and plan a Priority installation. Learn about the products
and how they interconnect to create the perfect work environment.
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»See page
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PRIORITY™

Progressive

Benching tables are

created by selecting:

® Progressive worksurfaces

e Undersurface support rails

e U-legs, open legs, end
panels, and/or undersur-
face storage

Center-mount shelves and
storage connect to U-legs
with stanchions using a
center-mount overhead shelf
bracket. Shelves keep shared
materials visible and within
easy reach.

U-legs are used to create
benching tables. Available in
fixed and adjustable-height
models.

Undersurface support
rails provide strength for the
worksurface, connecting
between support models.

Worksurfaces are available
in 24", 30", 36", 48", and 60"
widths. 24" or 30"D
worksurfaces are used for
dual-sided benching with
stanchions; 36", 48", and
60"D models provide a
continuous surface for U-legs
without stanchions.

Benching Solutions

Overview

Distinctives »See page 6

Typical Configurations

8

Page 40

Overhead storage is avail-
able in 36"-72" widths with
sliding door or hinged doors.
»See Systems Price List for
metal center-mount overheads.

Tiles mount to stanchions to
provide privacy above the
worksurface. Top caps,
shelves or overheads must
be specified to complete the
top of the tile run when using
stanchion U-leg support.

Shared mid-support
U-leg supports the ends of
two adjoining worksurfaces.
Available with or without
stanchions.

Privacy screens may be
mounted to top or edge or a
surface. Brackets for free-
standing screen applications
are also available.

End-support U-leg without
stanchions provides support
at the end of a run of sur-
faces. Available with or
without stanchions.

Low storage and mobile
cushion top pedestal can
stow under the surface

in a Progressive application.
Mobile BBF and FF units will
not stow below the surface
due to the location of the
undersurface support rails.

Statement of Line

13

Finishes & Materials

Dimensions:

209

og"
27%4"

48%46"

16"

47%e"
(487"

63%16"
(63"/4")*

700

47%¢"
25%¢" (487"

63%6"
(634"

41" 25%¢" s

* Dimensions in parentheses represent
Footprint center-mount overhead

11%46" :
1 T



PRIORITY™

Progressive

Materials:

Worksurfaces

e | aminate with a PVC rim
e Laminate with a wood rim
* Wood with wood rim

Supports
* Powder-coated steel

Storage
e Laminate
* Wood

Returns are created with
24", 30", and 36"D worksur-
faces, undersurface support
rails, return mounting
brackets, flat brackets, and
legs.

Tiles
e Fabric
e Slat

Privacy Screens
® Resin

Privacy screens may be

There is no length
limitation as to the
number of tables that can
be linked. There is no
dimensional creep.

specified at the same height
or width for consistent
aesthetics or at different
heights for function.

End-Support
U-Leg
Mid-Support
U-Leg
Mid-Support
U-Leg

Mid-Support
U-Leg

End-Support
U-Leg

Page 41

- . . Distinctives »See page 6
Benching Solutions Overview : —
Typical Configurations 8
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Collaboration work and
conference tables are
created by selecting:

® Progressive worksurfaces
e Undersurface support rails
e U-legs or open legs

PRIORITY™

Progressive

Privacy screens are avail-
able to provide privacy below
the worksurface.

Casters are available for field

installation, specified sepa-
rately, on individual tables.
Caster height is 178".

Factory-installed
grommets and cutouts are
available for power/data
centers.

For field-installed

Two sets of undersurface
support rails connect to U-
legs to provide strength.

grommets, note the
location of support legs to
eliminate interference with
grommets.

Shared mid-support

48" and 60" U-legs are
used to create conference
tables.

Worksurface depth
matches the depth of the
U-legs.

U-leg supports the ends of
two adjoining worksurfaces.

Page 42

Dimensions:

25%6"

27%4"

29"

% 30", 36", 48" or 60"D

T |

U

Materials:

Worksurfaces

e Laminate with a PVC rim
e Laminate with a wood rim
* Wood with wood rim

Supports
* Powder-coated steel

Privacy Screens
® Resin

- - . Distinctives »See page 6
Collaboration Solutions Overview — —~ —
ypical Configurations 8
Statement of Li 13
Work Tables & Conference Tables atement ot 1ine
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Desking configuration

can be created by selecting:

® Progressive worksurfaces

® U-legs, open legs, or end
panels

e Undersurface or low
storage

PRIORITY™

Progressive

Use vertical storage along
with low or undersurface
storage to create a work-
wall.

Face-mounted locks are
standard on all undersurface

Use worksurfaces with
low storage to create a
layered look. Select from rec-
tangular, wedge, arc-end, o